To begin, I want to clarify something specific for the people who have been using Autodesk® AutoCAD® Architecture software: you don’t need to tag an item in order for it to appear in a schedule in the Autodesk® Revit® Architecture platform. You can’t really just draft a schedule either. But this isn’t a bad situation to be in. Say, for example, that you have a typical door schedule. Wouldn’t it be nice to add a door to the model and have that door automatically show up in the schedule?

This chapter covers the following topics:

► Creating schedules
► Creating material takeoffs
► Creating key legends and importing CAD legends
► Adding tags
► Creating custom tags
► Keynoting

Creating Schedules

Revit allows you to schedule an item instantly based on a database. A door, for example, already has most of the information you need built into it. Didn’t it seem funny that when you placed a door in the model, it was automatically tagged with a sequential door number? This is the power of BIM. We’re now going beyond 3D.

Schedules don’t stop at doors and windows in Revit. You can schedule almost any item that goes into the model. Along with schedules comes the ability to quantify materials and areas. You can even create a schedule for the sole purpose of changing items in the model. In Revit, it’s always a two-way street.
The first topic we’ll tackle is creating the most common of the schedules in architecture: the door schedule. When you get this procedure down, you’ll be off and running.

The good news is that you have most of the information you need to create a multitude of schedules. The bad news is that Revit-produced schedules may not look like your company’s schedules at all. Before we go further, it’s important to note that some of you will be able to get a perfect duplication of your company’s standard schedules; some of you won’t. Those of you who don’t will have to get as close as possible to your standards and, at that point, know that sometimes the cost of doing BIM isn’t in the pocket but at the plotter.

Given that, let’s get started. I think you’ll find that creating and using schedules is a wonderful experience. You’re about to learn how to save hours upon hours of work, all the while maintaining 100 percent accuracy.

Adding Fields to a Schedule

To begin, open the file you’ve been using to follow along, or go to the book’s web page at www.sybex.com/go/revit2016ner. From there, you can browse to the Bonus Chapter 1 folder and find the file called NER-BC1.rvt. The following procedure focuses on creating a door schedule. Grab a cup of coffee or power drink, and follow along:

1. In the Project Browser, go to the Level 1 floor plan.
2. On the Create panel of the View tab, click the Schedules ➢ Schedule/Quantities button, as shown in Figure BC1.1.

**FIGURE BC1.1:** Click the Schedule/Quantities button on the View tab.
3. The next dialog box, as shown in Figure BC1.2, allows you to choose which item you would like to schedule. Select Doors, and click OK.

![New Schedule dialog box](image1)

**FIGURE BC1.2:** Select Doors, and then click OK.

4. The next dialog box lets you add the fields (parameters) required for your schedule. The first field you’ll add is Mark. To do this, select Mark in the Available Fields area to the left, and click the Add button in the middle of the dialog box to move the Mark field to the right, as shown in Figure BC1.3.

![Schedule Properties dialog box](image2)

**FIGURE BC1.3:** Adding the fields to produce a door schedule
5. Add the rest of the following fields using the same method (see Figure BC1.3):

- Height
- Width
- Level
- Finish
- Frame Material
- Frame Type
- Comments

6. Click OK. Your schedule should be similar to Figure BC1.4.

The next step is to start organizing your data in your preferred display format. You have a long way to go, but when you're finished, you can use this schedule over and over again.
NOTE A schedule doesn’t have to be placed on a drawing sheet. Many times, you’ll produce a schedule so that you can manipulate data without having to search for it in the model.

Sorting and Grouping

Because Revit is a database, think of building a schedule as creating a query in a database, because that’s exactly what you’re doing. By creating a sort, you can begin to see your doors in groups and have a tangible understanding of where you are. Let’s get started:

1. Because you never use lowercase lettering, click into the header and title rows and change the names to all capital letters, as shown in Figure BC1.5.

2. Select the rows that contain the headers from COMMENTS to MARK. Do this by clicking into the COMMENTS cell and dragging your cursor to the left.

FIGURE BC1.5: Edit all the field names, and change the shading of the row.
3. With the cells highlighted, click the Shading button (see Figure BC1.5).

4. Change the shading to the gray basic color shown in Figure BC1.5.

5. In the Properties dialog box is an Other category. Here you can return to the Schedule Properties dialog box. Click the Edit button in the Sorting/Grouping row, as shown in Figure BC1.6.


7. Select the Header option.

8. Select the Footer option.
9. Select Title, Count, And Totals from the Sort By drop-down list (see Figure BC1.7).

10. Click OK.

11. Save the model.

The next step is to group the header information the way you would like it. Most schedules include groups such as Frame Material and Frame Type. You’ll create similar groupings.

**Controlling Headers**

Although this step isn’t crucial to producing an accurate, readable schedule, it’s important in the attempt to get this Revit-produced schedule to look like the schedule you’ve been using for years in CAD. The objective of this procedure is to combine the header content into smaller groups under their own header, similar to what you can do in a spreadsheet.

To begin controlling the schedule headers, follow these steps:

1. In the Project Browser, open DOOR SCHEDULE (if you don’t already have it open).
At the top of the schedule are the title (DOOR SCHEDULE) and the headers (which include MARK, HEIGHT, WIDTH, and LEVEL, among others), as shown in Figure BC1.8. Focus your attention here.

**FIGURE BC1.8:** Click and drag across the four cells to activate the Group button.

2. The goal is to combine MARK, HEIGHT, WIDTH, and LEVEL into a group under one header called DOOR INFORMATION. To do this, click the LEVEL cell, and drag your cursor to the left. You’re selecting all four cells.

3. When the cells are selected, click the Group button on the Headers panel.

**T I P** Sometimes when you’re picking the first cell to do this task, you’ll accidentally click into the cell. You don’t want this. If this keeps happening, click into the LEVEL cell, and then click just below the cell into the gray area. Doing so selects the cell the way you want it. You can now pick the cell and drag your cursor to the left to highlight all the cells.

4. Click into the new cell, and type DOOR INFORMATION.
Creating Schedules

It would be nice if the defaults in Revit were all caps, but they aren't. The next procedure will rename some of the headers, but it won't change any values:

1. Click in the MARK header (see Figure BC1.9), and change it to DOOR NUMBER.

![Figure BC1.9: Adding the new header and changing the descriptions](image)

2. Change the LEVEL header to FLOOR.
3. Select the cells FRAME MATERIAL and FRAME TYPE.
4. On the Options bar, click Group in the Headers panel.
5. Call the new header FRAME INFORMATION (see Figure BC1.10).

![Figure BC1.10: The groups are complete.](image)

Now it’s time to begin filling out some of the blank fields. This is where you can increase productivity by using schedules. Instead of going door by door in the model, you have a list of every door right in front of you!
Modifying Elements in a Schedule

In Revit, data flows in multiple directions. When you created a schedule, the data from the doors flowed into the schedule to populate it. Now you’ll ask Revit to collect data that you input into the schedule to flow into the doors.

To learn how to populate the schedule, follow along with this procedure:

1. In the Project Browser, open DOOR SCHEDULE (if it isn't open already).

   **NOTE** Note that Door Schedule is now DOOR SCHEDULE in the Project Browser. This is because you renamed the title in the schedule—proof that you’re dealing with bidirectional information.

2. Click into the FINISH cell for door number 101.
3. Type PT (for paint).
4. Click in the FINISH cell below the one you just changed.
5. Click the menu arrow, and notice that PT is in the list. Click PT (see Figure BC1.11).

   **FIGURE BC1.11:** When you start filling out the fields in a schedule, the items become available in the list for future use.

6. Save the model.

   Let’s see how this affected the actual doors in the model and perhaps find a door that needs to be tagged with a WD (wood) finish:

   1. In the Project Browser, open the Level 1 floor plan.
   2. Zoom in on the door between the corridor and the east wing, as shown in Figure BC1.12.
3. Select the door.

4. In the Properties dialog box, scroll down to the Materials And Finish category, and find Finish.

5. Click in the Finish field, and type **WD** (see Figure BC1.12).

6. Click the Apply button at the bottom of the Properties dialog box.

7. Open the door schedule. Notice that door 100B has a WD finish.

8. Save the model.

In the interest of not getting carried away with the mundane process of filling out the entire schedule, note that this process is applicable for every field in this type of schedule. The main takeaway is that you can populate a schedule either...
by changing the data in the schedule itself or by finding the scheduled component, such as a door or window, and changing it there.

NOTE Also, it’s worthwhile to note that if you click any row in the schedule, the Element panel has a Highlight In Model tool that essentially does the same thing as right-clicking.

The next step is to further modify the appearance of the schedule on which you’re working. You can then begin using this schedule to focus on a specific group of doors and change them based on a filter.

Modifying the Schedule’s Appearance

As it stands, not everyone uses the same fonts, headers, and linework around the border of the schedule.

The objective of this procedure is to examine what font this schedule is using, as well as the line weights and spacing applied to the schedule. To learn how to adjust the appearance of a schedule, follow along:

1. In the Project Browser, open DOOR SCHEDULE (if it isn't open already).

2. In the Properties dialog box, click the Edit button for Appearance.

3. On the Appearance tab of the Schedule Properties dialog box are two categories: Graphics and Text. In the Graphics category, click Outline and select Medium Lines, as shown in Figure BC1.13.

FIGURE BC1.13: Configuring the schedule’s appearance
4. In the Text category, make sure Show Title and Show Headers are selected (see Figure BC1.13).

5. Click OK.

**Using the Schedule to Find a Component**

In some cases, while you’re filling out the schedule, you may not be sure which item you’re looking at. Because schedules are “live,” you can find a component from the schedule. To do this, follow these steps:

1. In the schedule, right-click door 114.
2. Select Show.

Revit zooms in on the door and even gives you choices to find other views.

3. Click Close.
4. Close the view, and go back to the schedule.
Your schedule doesn’t change one bit! You’ve simply created a situation where the appearance of the schedule won’t be apparent until you literally drag it onto a drawing sheet.

Adding a Schedule to a Sheet

Now let’s add the schedule to the sheet. To do this, perform the following steps:

1. In the Project Browser, find the Sheets (All) category, as shown in Figure BC1.14. Coincidentally, it’s located directly below Schedules/Quantities.

![Figure BC1.14: Creating a new sheet](image)

Hey, This Looks Familiar

You may have noticed that each time you open the properties of the schedule and click the Edit button next to a corresponding row (in this case, the Appearance row), you’re only jumping to a specific tab of the Schedule Properties dialog box. Each schedule category can be accessed in one dialog box, as shown in the following image:

![Schedule Properties dialog box](image)
2. Right-click Sheets (All).

3. Select New Sheet (see Figure BC1.14).

4. Select E1 30 x 42 Horizontal, as shown in Figure BC1.15, and click OK.

![Using a sample title block](image)

**FIGURE BC1.15:** Using a sample title block

You now have a new sheet containing a blank title block, as shown in Figure BC1.16.

![A new sheet, ready to be populated](image)

**FIGURE BC1.16:** A new sheet, ready to be populated
The next objective is to click and drag the schedule onto the sheet. If the schedule fits, this is the easiest thing to do in Revit:

1. In the Project Browser, find DOOR SCHEDULE.

2. Click it, but don’t double-click it—pick it and hold down the left mouse button.

3. With the left mouse button pressed, drag the schedule onto the sheet. You can place it anywhere you see fit (see Figure BC1.17).

4. When you’ve moved your cursor to the desired position, release the mouse button. If the bottom hangs over the sheet, that’s okay—you’ll fix it in a minute.

5. Notice the blue break grip located halfway up the schedule. This is the same type of grip that is used in grids, levels, and sections. Pick it, as shown in Figure BC1.18.
FIGURE BC1.18: You can split the schedule into two (or more) sections.

6. With the schedule split in two, you can see that it fits onto the sheet quite nicely. With the schedule still selected, notice the blue grip at the lower left, as shown in Figure BC1.19. Pick the grip and drag. You can slide the schedule so that the length of each side adjusts up and down evenly.

FIGURE BC1.19: You can make further adjustments to the schedule by picking the round blue grip.
7. Zoom in on the top of the schedule, as shown in Figure BC1.20, and select the schedule.

![Figure BC1.20](image)

**FIGURE BC1.20:** Pick the triangle grip to give the COMMENTS field some more room.

8. There are blue triangle-shaped icons at each cell in the title and the header. Pick the one on the COMMENTS column, and drag it to the right. The COMMENTS header is now readable.

You can make two more adjustments to the schedule after you place it onto a sheet. They involve rotating and joining the two columns back together:

1. Select the schedule (if it isn’t already selected).
   On the Modify | Schedule Graphics tab is a Rotation On Sheet menu on the Options bar, as shown at the upper left in Figure BC1.21. You don’t need to change the rotation—just note that it’s there.

2. Also notice the blue move grips in the upper-left corners of the schedules. If you pick one and drag the column back over the top of the other, the columns automatically join back together (see Figure BC1.21).

3. Save the model.
To nail down the concept, let’s create a window schedule. If you like, go ahead and make one on your own. You can compare it to the one in the book when you’ve finished to see if you got it right. If you would rather go step by step, that’s fine too! Just follow along:

1. On the View tab, click the Schedules ➢ Schedule/Quantities button. Note that you can also right-click Schedules in the Project Browser to create a new schedule.

2. In the next dialog box, select Windows and click OK.

3. In the Schedule Properties dialog box, add the following fields (see Figure BC1.22):
4. Go to the Sorting/Grouping tab, as shown in Figure BC1.23.

5. Sort by Type Mark.

6. Add a footer, with Title, Count, And Totals selected.
7. Choose Level from the Then By drop-down list.

8. Select the Grand Totals option.

9. Select Title, Count, And Totals from the Grand Totals drop-down list.

10. Select the Itemize Every Instance option. (It should be checked by default; see Figure BC1.23.)

11. Click OK to get to the schedule and see the results.

Sometimes, you may want to sort items based on a field but not actually display that field. Here’s how:

1. Select a cell in the Level column, as shown in Figure BC1.24.

   ![Figure BC1.24](image)
   
   **Figure BC1.24:** You can hide a column but still have Revit sort the schedule based on the hidden information.

2. Click the Hide button. This hides the column.

3. Save the model.
NOTE It’s worth noting that you can create a schedule before you add any information to the model. You can then add this schedule to a sheet and save the entire file as a template. Whenever you start a new project, these schedules will start filling themselves out and will already be on sheets.

Phew! I think you get the picture. If you like, feel free to create a bunch of schedules on your own. Practice does make perfect.

Let’s venture now into creating a material takeoff. It would be a shame to have all these computations go unused!

Creating Material Takeoffs

Creating a material takeoff is similar to creating a schedule. The only difference is that you’re breaking down components and scheduling the smaller pieces. For example, as you know, you can make a schedule of all the doors in the model—you just did that. But with a material takeoff, you can quantify the square footage of door panels or glass in the doors. To take it a step further, you can do material takeoffs of walls, floors, and any other building components you want to quantify.

The objective of this procedure is to create three different material takeoffs: one for the walls, one for the floors, and one for the roofs. Let’s get started:

1. On the View tab, click Schedules ➢ Material Takeoff, as shown in Figure BC1.25.

![Figure BC1.25](image-url)

**FIGURE BC1.25:** To add a new material takeoff, you can go to the View tab.
2. In the New Material Takeoff dialog box, select Walls, as shown in Figure BC1.26.

![New Material Takeoff dialog box](image)

**Figure BC1.26:** Select Walls in the New Material Takeoff dialog box.

3. Click OK.

4. In the next dialog box, add the following fields (see Figure BC1.27):

![Material Takeoff Properties dialog box](image)

**Figure BC1.27:** Adding the materials

- Material: Area
- Material: Name
- Count
5. Select the Sorting/Grouping tab.


7. Add a footer.

8. Choose Title, Count, And Totals from the drop-down menu at the top, as shown in Figure BC1.28.

![Figure BC1.28: Configuring the parameters for the schedule](image)

9. Select the Blank Line option.

10. At the bottom of the dialog box, select Grand Totals.

11. Choose Title, Count, And Totals from the drop-down menu.

12. Select the option Itemize Every Instance (see Figure BC1.28).

13. Click OK.
The next step is to begin taking some totals on your own. The first thing you can do is have Revit automatically format a column to produce an independent total; then, you can break out this takeoff and drill into more specific line-item totals:

1. In the Properties dialog box, click the Edit button next to the Formatting row to bring up the Material Takeoff Properties dialog box, shown in Figure BC1.29.

![Figure BC1.29](image)

**Figure BC1.29**: On the Formatting tab, you can specify Calculate Totals for the Material: Area option.

2. In the field to the left, select Material: Area.

3. On the right, select Calculate Totals.

4. Click OK.

You now have a total area at the bottom of your takeoff groups, as shown in Figure BC1.30.
The next step is to break this takeoff into smaller, more specific takeoffs. When you do this, you can provide your own calculations based on almost any formula you need.

### Creating a Calculated Value Field

The objective here is to create separate schedules for plywood and gypsum by adding a new variable to the schedule that contains a formula you create. Yes, it’s as hard as it sounds, but after you get used to this procedure, it won’t be so bad! Perform the following steps:

1. In the Project Browser, right-click Wall Material Takeoff, and select Duplicate View ➔ Duplicate, as shown in Figure BC1.31.
2. Right-click the new view in the Project Browser, and select Rename.
3. Rename the view Plywood Takeoff.
4. In the Properties dialog box, click the Edit button in the Filter row.

5. For Filter By, choose Material: Name.

6. In the menu to the right, select Equals from the list.

7. In the field below Material: Name, select Plywood, Sheathing (see Figure BC1.32).

8. Click OK.
Your takeoff should look like Figure BC1.33.

The next step is to break down the plywood into 4×8 sheets. You'll need to add a formula based on the square footage given by Revit divided by 32 square feet to come up with the plywood totals:

1. Open the Plywood Takeoff schedule in the Project Browser (if it isn't already open).
2. In the Properties dialog box, click the Edit button in the Fields row.
3. On the Fields tab in the Material Takeoff Properties dialog box, click the Calculated Value button, as shown in Figure BC1.34.
4. For the name, enter Number of Sheets.
5. Make sure Discipline is set to Common.
6. Make sure Type is set to Number (see Figure BC1.35).
FIGURE BC1.34: Click the Calculated Value button in the middle of the dialog box.

FIGURE BC1.35: Changing the calculated values

7. Add the following formula: **Material: Area / 32 SF** (metric users type this formula: **Material: Area / 2.88 SF**).

8. Click **OK**.

9. Select the Formatting tab, as shown in Figure BC1.36.

You must type the fields being used exactly as they're displayed. For example, the formula **Material: Area** must be typed exactly as specified in terms of spacing and capitalization. All formulas in Revit are case sensitive. You can also click the [...] button to add the available fields.
10. Select the new field called Number of Sheets.
11. In the Field Formatting section, select Calculate Totals (see Figure BC1.36).
12. Click the Field Format button.
13. Deselect Use Default Settings, as shown in Figure BC1.37.

![Figure BC1.36: Selecting the Calculate Totals option](image1)

**Figure BC1.36:** Selecting the Calculate Totals option

![Figure BC1.37: Overriding the units to allow this field to round](image2)

**Figure BC1.37:** Overriding the units to allow this field to round
14. Change Units to Fixed.
15. Make sure Rounding is set to 0 Decimal Places.
16. Select Use Digit Grouping (see Figure BC1.37).
17. Click OK.
18. Select the Sorting/Grouping tab.
19. At the bottom, select the Grand Totals option if it isn’t selected already.
20. Click OK.

Your material takeoff should resemble Figure BC1.38.

![Plywood Takeoff Table]

**FIGURE BC1.38:** The finished plywood material takeoff

Wow! Not too bad for only drawing a bunch of walls. As you can see, using the scheduling/material takeoff feature of Revit adds value to this application. Well, the value doesn’t stop there. You can use the same functionality to create legends and drawing keys as well.
Creating Key Legends and Importing CAD Legends

Here’s the problem with Revit. At some point, you’ll need to add a component to the model that isn’t associated with anything. Say, for example, you have a door that you would like to elevate on a sheet with the door schedule. You sure don’t want that door included in the schedule, and you sure don’t want to have to draw a wall just to display it. This is where creating a key legend comes into play.

Adding Legend Components

The objective of the following procedure is to create a key legend, adding elevations of doors that are used in the model. As it stands, a legend can mean any number of things. It can be a list of abbreviations, it can be a comprehensive numbering system keyed off the model itself, or it can be a graphical representation of items that have already been placed into the model for further detailing and coordinating. Another special aspect of legends is that a single legend may need to be duplicated on multiple sheets in a drawing set. You don’t know it yet, but this is a problem for Revit. By creating a legend, however, you can get around this issue.

Follow these steps to create a door-type legend:

1. On the View tab, click the Legends ➢ Legend button, as shown in Figure BC1.39. You can also right-click Legends in the Project Browser and pick New Legend.

2. The next dialog box wants you to specify a scale. Choose 1/4” = 1’–0” (1:50 mm). This is fine for now (see Figure BC1.40).
3. Call the view Door Type Legend.
4. Click OK.

Congratulations! You now have a blank view. This is actually a good thing. Think of it as a clean slate where you can draft, add components, and throw together a legend.

**Other Functions Have Been Activated**

Without knowing it, you’ve made some tools available that we haven’t explored yet. You’ll start to learn that Revit knows the type of view you happen to be in at present. Some commands are available in one view, but they may not be in the next. Keep this in mind as you venture through Revit and become frustrated that a command isn’t working. You usually just need to switch views.

The next step is to begin adding components. You’ll need to go to the Annotate tab for this:

1. Go to the Detail panel of the Annotate tab.
2. Click the Component ➢ Legend Component button.
3. In the Options bar, choose Doors : Single-Raised Panel with Sidelights : 36” × 84”, as shown in Figure BC1.41.
4. Change the view to Elevation: Front.

5. Pick a point to place the elevation.

6. With the command still running, you can place another instance.

7. Change the view to Floor Plan. Place another instance of the door just above the elevation, as shown in Figure BC1.42. Revit provides a snap line on the left side for alignment.
8. In the Options bar, be sure Host Length is set to 6′–0″ (1800 mm) (see Figure BC1.42).

9. With the command still running, choose Doors : Double-Flush : 68″ × 84″ and place it to the right of the first door. Make sure View is set to Elevation : Front.

10. Place the corresponding plan view just above the door. Make sure Host Length is set to 6′–0″ (1800 mm) (see Figure BC1.43).
The next step is to add some text in an attempt to label the doors. These items can’t be labeled, which can be a disadvantage to breaking away from the model. This is basically a dumb sheet. Follow along:

1. On the Text panel, click the Text button.

2. Make sure the text style is Text: 3/32” Arial and that the leader is set to None, as shown in Figure BC1.44.
3. Place some text centered under each door elevation, and label the doors Type A and Type B (see Figure BC1.44).

4. Save the model.

It’s nice to have accurate blocks available based on what you’ve added to your model up to this point. By using the Revit method of building a legend like this, you’re removed from the horror of stealing old legends from other jobs. I think we all know what a nightmare this turns into when they aren’t accurate. Plus, in Revit, you have a library of the doors you’re using right at your fingertips. They don’t have to be managed or updated constantly. They will always be there, and they will always be accurate.

Next, you’ll create a symbol legend—that is, you need to make a sheet that contains all your typical symbols. This task will be carried out in a similar manner.

**Adding Symbols to a Legend**

As mentioned earlier, adding symbols to a legend is similar to creating a door legend. The only difference is that you’ll add your typical symbols as they appear on the sheets. Most companies have a sheet like this; I’m sure yours does, too.

The first objective is to create this legend from scratch using the Revit tools. The second objective is to import your legend from CAD (which I’m sure you have). After you complete the two procedures, you can decide which approach is best for your firm.

**Using the Revit Symbols**

To use the Revit-provided symbols, you’ll create a new legend view, and you’ll use the Annotate tab to insert the typical components. If you’re feeling brave, go ahead and make a symbol key on your own. You can follow the figures to make sure you’re adding the expected components. If you would rather follow along with the procedure, let’s get started:

1. On the View tab, click the Legends ➢ Legend button.
2. Set the scale to $1/4” = 1’-0”$ (1:50 mm).
3. Call the new legend Symbol Legend.
4. Click OK.
5. On the Symbol panel of the Annotate tab, click the Symbol button, as shown in Figure BC1.45.
6. In the Type Selector, select Callout Head.

7. Place the callout head into the view (see Figure BC1.46).

8. With the Symbol command still running, place a door tag directly underneath the callout head, as shown in Figure BC1.47.
9. Place a Room Tag With Area.

10. Place a View Title (see Figure BC1.47).

The next step is to add some notes to indicate what you just added to the legend. Again, you won’t be tagging the items—you’re merely placing text and leaders:

1. On the Text panel of the Annotate tab, click the Text button.

2. On the Modify | Place Text tab, click the One Segment button, as shown in Figure BC1.48.
3. Pick two points for the leader, and type TYPICAL CALLOUT (see Figure BC1.48).

4. Add the following notes to the rest of the symbols (see Figure BC1.49):

   ![Diagram](image)

   **Figure BC1.49**: Adding descriptive text

   - TYPICAL DOOR TAG
   - TYPICAL ROOM TAG
   - TYPICAL VIEW TITLE

   Now you’ll place a box around the items and draw three equal lines to make a grid. You do this by strictly drafting lines, as the following procedure shows:

   1. On the Annotate tab, click the Detail Line button, as shown in Figure BC1.50.
Creating Key Legends and Importing CAD Legends

2. In the Properties dialog box, be sure Thin Lines is selected.

FIGURE BC1.50: Click the Detail Line button on the Annotate tab.

FIGURE BC1.51: Adding the linework around the symbols and text.
3. On the Draw panel of the Modify | Place Detail Lines tab, click the Rectangle button (see Figure BC1.51).
4. Draw a rectangle around the symbols and the text (see Figure BC1.51).
5. On the Draw panel, click the Line button.
6. Draw three horizontal lines in the box. They don’t have to be equally spaced, but they should separate the symbols.
7. Place a dimension string starting at the top of the rectangle (the first line you drew), and going down to the second line, to the third, to the fourth, and then to the bottom of the rectangle.
8. Click the EQ button on the dimension string.
9. Move the symbols and the text to the proper positions (see Figure BC1.52).

**Figure BC1.52:** Draw the horizontal lines, and then equally constrain them using the Dimension command.

10. Delete the dimensions.
11. Click OK in the next dialog box.
12. Save the model.
Now that you have experience with creating legends using strictly Revit components and lines, it’s time to investigate how you can use a premade AutoCAD legend as an import.

**Importing AutoCAD Legends**

Just because you’ve switched to Revit doesn’t mean you must throw away over a decade of work regarding typical details and legends. Revit accepts Autodesk® AutoCAD® and MicroStation DWG and DGN files just fine. Of course, there will be some tweaking, but when you get the process down, I think you’ll rely heavily on this functionality.

The objective of the following procedure is to create a new legend view and then import an existing AutoCAD legend into the view. To get started, go to this book’s web page at www.sybex.com/go/revit2016ner. From there, you can browse to Bonus Chapter 1 and find the file Interior Partition Legend.dwg. Place the drawing file on your system in a place where you can retrieve it later. Now follow these steps:

1. On the View tab, click the Legends ➢ Legend button.
2. Call the new legend Interior Partition Legend.
3. Make the scale 1” = 1’–0” (one inch equals one foot) (1:10 mm), and click OK.
4. On the Insert tab, click Import CAD, as shown in Figure BC1.53.
5. Find the AutoCAD DWG file Interior Partition Legend.dwg.

**WARNING** Don’t click Open until you’re instructed to do so. We need to look at several items in the Import CAD Formats dialog box that have a crucial effect on the imported graphics.

6. At the bottom of the Import CAD Formats dialog box, notice that you have a few choices:

   - **Colors** Change Colors to Black And White.
   - **Layers** Make sure Layers is set to All. You’ll be able to manipulate the AutoCAD layers after you bring the DWG file into Revit.
Import Units  Import Units should be set to Auto-Detect. In some cases, you'll have to modify this choice, such as importing a site, but for now, leave it as Auto-Detect.

Positioning  Leave Positioning set to Auto-Center To Center.

7. Click Open.

After you import the CAD file, it may be zoomed off the view so that you can’t see it. Follow this procedure to zoom the CAD import into view and manipulate the data:

1. Type ZA (to zoom all).

2. You can now see the import. Select it.

3. On the Modify | Interior Partition Legend.dwg tab, in the Import Instance panel, click the Query button, as shown in Figure BC1.54.
4. Select the line shown in Figure BC1.54.

5. After you select the line, Revit reports information to you about that line. You’re also given the chance to delete the layer. Click Delete, as shown in Figure BC1.55.

![Figure BC1.55: You can query items in the CAD import. You can also delete items.](image)

6. Click OK. All of the lines on that layer are gone.

7. Press Esc twice.

**WARNING** Be careful when you delete layers. Revit isn’t like AutoCAD. When you delete a layer in Revit, any object that happens to be on that layer is deleted as well. You can easily delete objects inadvertently.

The next step is to fix some of the text that didn’t quite wrap correctly. You need to explode the import so that it’s broken down into Revit lines and objects:

1. Select the import again.

2. On the Modify | Interior Partition Legend.dwg tab, click Explode ➢ Full Explode, as shown in Figure BC1.56.

![Figure BC1.56: Click the Full Explode button on the Modify | Interior Partition Legend.dwg tab.](image)
**NOTE** The difference between Full Explode and Partial Explode is that a partial explode breaks the import down to the next level of blocks. For example, if a block was included in the drawing file, such as a column bubble, then a partial explode would break down the import but leave the column bubble as a block. When you do a full explode, you’re exploding every object in the import—blocks and all.

3. Select the text METAL STUDS AT 16” O.C. WITH TOP DEFLECTION TRACK for the ME- detail.

4. Pick the grip to the right, and drag the text box to the right until the text wraps into the correct position, as shown in Figure BC1.57.

5. Do the same for the other details that have improperly wrapped text.

6. Save the model.

**NOTE** You may ask, “How did Revit know what line weights to use for my import?” This is a great question. You can configure the import/export settings to translate AutoCAD colors to Revit line weights. If you’re using standard AIA layering, you’ll have very little problem with this translation. If not, you may have some work to do. Chapter 11, “Detailing,” shows how to configure this file.

Now that you have experience with keys, let’s move on to learn how tags work in Revit and why we address them along with schedules.
Adding Tags

Up to this point, you’ve probably noticed that some subjects, such as tags, were brushed over in earlier chapters. Tags simply can’t be avoided because they come in automatically with many items. But a mystery surrounds them. Where do they come from, how does Revit know what tag to associate with what element, and how the heck do you make Revit tags look like your tags?

You can almost see a tag as a “window” looking into the item itself. A tag allows you to pull a parameter out of an item and put that parameter onto the drawing in a physical sense. Given that, tags are how you label things.

To start, let’s concentrate on the simple and then move to the more complex. First, you’ll learn how to add a tag that wasn’t added automatically.

Adding Tags Individually

As you may have noticed, not everything you placed in the model received a tag—especially many of the doors and windows that you copied to different floors. The objective of the following procedures is to add tags to individual objects. The first type of tag will be by category.

Tagging by Category

Tagging an item by category means that when you start the Tag command, it looks for an entire object to tag with the loaded tag that was created specifically for that object:

1. In the Project Browser, go to the Level 2 floor plan.
2. Zoom in on the area where the corridor meets the east wing, as shown in Figure BC1.58.
3. On the Tag panel of the Annotate tab, click the Tag By Category button, as shown in Figure BC1.59.

4. On the Options bar, deselect the Leader option.
5. Pick the door shown in Figure BC1.60. Your tag is added.

![Figure BC1.60: Tagging the door. Be sure you deselect Leader on the Options bar.](image)

Adding tags to doors is a straightforward concept. Keep in mind, however, that doors and windows are certainly not the only taggable items in Revit.

**Tagging Walls**

Tagging walls is almost as automatic as tagging doors and windows. The only difference is that when you tag a wall, the tag is initially blank.

To learn how to tag a wall, follow along with this procedure:

1. In the Project Browser, go to the Level 2 floor plan if you aren’t there already.
2. Zoom in on the east wing.
3. Click the Tag By Category button.
4. Make sure the Leader option is checked.
5. Pick the wall indicated in Figure BC1.61.
6. Many times, you won’t have a tag loaded for this specific type of item. If that situation occurs, you’ll get the message shown in Figure BC1.62. If you want to load a tag, click Yes to do so. If you don’t, proceed to step 14.

![Message dialog box](Image)

**FIGURE BC1.62:** When you try to tag an item without a specific tag type loaded, this dialog box prompts you to load the tag.

7. In the Load Family dialog box, select Annotations ➔ Architectural ➔ Wall Tag.rfa.

8. Click Open.

9. On the Options bar, click the Leader option so the tag is leadered into the wall.

10. On the Architecture tab in the title bar of the Tag panel is a pull-down arrow. Click the Loaded Tags button (see Figure BC1.63).
11. In the Loaded Tags dialog box, scroll down to Walls, as shown in Figure BC1.64.

12. In the Loaded Tags cell for Walls, pick Wall Tag : 1/2”.
13. Click OK.
14. Pick the wall again. You now have a wall tag.
15. Press Esc twice.
16. Select the new wall tag (it’s blank).
17. Notice the blue items. Click the blue question mark in the tag.
18. Call it MC-1, as shown in Figure BC1.65.
19. Click Yes in response to the warning that you’re changing a type parameter.

20. Press Esc.

21. Click Tag By Category on the Annotate tab.

22. Pick any other corridor partition in the floor. This time the tag is automatically placed with the appropriate MC-1 tag filled out.

Suppose you would like to tag a number of the same items in one shot. Revit lets you do this by using the Tag All command.

**Using the Tag All Command**

The Tag All command is a favorite among Revit users. One of the most common examples of using this command is when you Copy/Paste Aligned multiple items to higher-level floors. You’ll almost always miss a few tags, or even all of the tags. This is where Tag All comes into play.

The goal of this next procedure is to find the Tag All feature and tag several items in one shot:

1. In the Project Browser, go to the Level 4 floor plan.

2. Notice that many doors and windows aren’t tagged. (If for some reason all the doors and windows are tagged, select the tags and delete them for this procedure.)
**But Where Is That Information Stored?**

When you modify this type of tag, it’s generally the type mark that carries the data. To see the location of the type mark, select any one of the interior partitions, and click Edit Type in the Properties dialog box. In the Type Parameters field, you can scroll down to find Type Mark, as shown in the following image:

![Type Properties dialog box](image)

This information is also tied into the schedule. As you’re selecting fields to add to the schedule, you’re selecting from the same list that Revit used to tag items in the model. This is the definition of BIM: the right information is used in the right places.

3. On the Annotate tab, click the Tag All button, as shown in Figure BC1.66.

![Annotate tab](image)

**Figure BC1.66:** The Tag All button on the Annotate tab
4. In the Tag All Not Tagged dialog box, click Door Tags.

5. Hold the Ctrl key, and scroll down and select Window Tags. This specifies that every door and window in the view is about to receive a tag.

6. Make sure the All Objects In Current View radio button is selected (see Figure BC1.67).

![Tag All Not Tagged dialog box](image)

Figure BC1.67: Selecting door and window tags

7. Click Apply.

8. Click OK.

It almost goes without saying that Tag All is quite a valuable tool. Another valuable tool is the ability to reach into a component and tag specific material within the component.
Tagging by Material

Tagging By Material may be one of the most underused commands in all of Revit. The reason is that most people think of a tag as, well, a tag—a drawn box containing some abbreviations or letters. That's too bad, because you can also use tags as a means to place notes. Tagging an item's material is one way of doing just that.

The objective of the following procedure is to create a material description and then place a tag pursuant to that note:

1. In the Project Browser, go to the Level 1 floor plan.
2. Zoom in on the kitchen area in the east wing.
3. On the Tag panel of the Annotate tab, click the Material Tag button, as shown in Figure BC1.68.

![Image of Material Tag button on Tag panel]

**FIGURE BC1.68**: The Material Tag button on the Tag panel

4. You may get the message stating that no material tag family is loaded into the model. If so, click the Yes button to load one.
5. Browse to Annotations ➢ Architectural ➢ Material Tag.rfa.
6. Click Open.
7. Place your cursor over the tile floor, as shown in Figure BC1.69. The tag reads “Porcelain tile, 4″, white.” When you see this tag, pick a point on the tile floor, and then place the note to the right, as shown in the figure.
8. Press Esc twice, or click Modify.

9. Select the tag.

10. In the Properties dialog box, click Edit Type.

11. Change Leader Arrowhead to Arrow Filled 15 Degree, as shown in Figure BC1.70.

12. Click OK to reveal the leader. Yes, that looks much better.
Creating Custom Tags

The next topic we’ll explore is where these tags come from and how you can create your own. Notations and symbols are the basis for maintaining graphical standards. If you simply use the examples given to you by Revit, you’ll have a set of drawings that look very generic and immediately turn off your design team.

Creating Custom Tags

As mentioned before, templates very much drive how Revit works. Creating families is a prime example of this. To create a custom tag, you must first create a family and then load it into your drawing. The tag you’ll create is a casework tag. Revit does provide one, but yours needs to be smaller (based on scale), and it needs a box surrounding it.

To learn how to create a custom tag from scratch, follow along:

1. Click the Application button, and select New ➢ Family.
2. Browse to the Annotations folder.
4. Click Open.

Welcome to the Family Editor! The first thing you may notice is the large block of text in the middle of the view that says, “Note: Use Settings | Family Categories to set the tag’s category. Insertion point is at intersection of ref planes. Delete this note before using.”

This is a great note, and you need to start by taking its advice:

1. Select the note, and click the Delete button (or press the Delete key on your keyboard).
2. Click the Family Category And Parameters button, as shown in Figure BC1.71.

![Family Category And Parameters button](image)

**Figure BC1.71:** The Family Category And Parameters button
3. In the Family Category And Parameters dialog box, select Casework Tags, as shown in Figure BC1.72.

![Family Category and Parameters dialog box](image)

**Figure BC1.72:** Selecting Casework Tags

4. Click OK.

Notice that the Ribbon has changed. The only items available are designed to aid you in the creation of a family.

1. In the Text panel on the Create tab, click the Label button, as shown in Figure BC1.73.

![Text panel on Create tab](image)

**Figure BC1.73:** Clicking the Label button
2. Click the Edit Type button in the Properties dialog box.

3. Click Duplicate.

4. Call the new label 1/16” (1.5 mm).

5. Click OK.

6. In the Text category, change Text Size to 1/16” (1.5 mm).

7. Change Width Factor to 0.8.

8. Click OK.

9. In the model, place the tag directly on the intersection of the reference planes (you’ll have to eyeball the placement).

10. In the Edit Label dialog box, select Type Mark from the list to the left.

11. In the middle of the Edit Label dialog box, click the Add Parameter(s) To Label button. The Type Mark parameter should appear in the right field, as shown in Figure BC1.74.

12. Click OK.

13. Press Esc twice.
The label has been added. It’s small, but it’s there. The next step is to draw a rectangle around this text. The following procedure describes how:

1. On the Create tab, click the Line button in the Detail panel.
2. In the Draw panel, click the Pick Lines icon.
3. On the Options bar, change the Offset value to 1/16” (1.5 mm).
4. Zoom into the label, and then offset the horizontal reference plane up 1/16” (1.5 mm) and down 1/16” (1.5 mm), as shown in Figure BC1.75.

![Figure BC1.75: Offsetting the horizontal reference plane up and down](image)

5. On the Options bar, change the Offset value to 1/8” (3 mm).
6. Offset the vertical reference plane to the left and to the right 1/8” (3 mm), as shown in Figure BC1.76.

![Figure BC1.76: Creating the box](image)

7. Trim the four corners.
8. Press Esc.

9. Save the file as **Casework Tag.rfa**. Make sure you save the file in a location where you can find it later.

10. On the Family Editor panel, click the Load Into Project button.

---

**Which One Do I Choose?**

If you have more than one model open (other than this family), you’ll see a dialog box asking you to select the file into which you wish to load the family. If this happens, select **NER–BC1.rvt** (or the file on which you’re working), as shown here:

![Load into Projects dialog box](image)

With the new tag loaded into the project, you can now use it. Because it’s a casework tag, you need to find some casework to label, as follows:

1. In the Project Browser, go to the interior elevation called Kitchen North. You can also go to the Level 1 floor plan and zoom in on the kitchen. From there, double-click the elevation marker pointing at the north leg of the kitchen.

2. Zoom in on the cabinets, as shown in Figure BC1.77.
3. On the Tag panel on the Annotate tab, click the Tag By Category button.

4. On the Options bar, deselect Leader.

5. Pick the base cabinet with two doors and one drawer (see Figure BC1.77).

6. Move the tag underneath the cabinet.

7. Select the question mark in the tag. (You'll see it once you select the tag.)

8. Rename the tag B2D1D, as shown in Figure BC1.78, and then click Yes.
Because this is an annotation family, the size changes with the fluctuation of the scale. If you change the scale from 1/8” (1:100 mm) to 1/4” (1:50 mm), the tag will shrink by half. To do this, follow along:

1. On the View Control toolbar, change the scale from 1/8” = 1’–0” (1:100 mm) to 1/4” = 1’–0” (1:50 mm), as shown in Figure BC1.79.

2. Move the tag up so it's closer to the cabinet.

3. Add another tag to the cabinet to the right.

4. Call it B1D1D (see Figure BC1.79).

As you can see, this is a huge step beyond inserting a block in a 2D drafting application and filling out an attribute that has nothing to do with the actual element it’s labeling. In addition, the scaling feature works wonders when it comes time to create elevations and enlarged views.

The next topic to explore is creating a tag that will work in any situation you need—sort of a multipurpose tag.
Using Multi-Category Tags

If you think about it, you used a door tag for the doors, a window tag for the windows, and a wall tag for the walls. Jeepers! How many different tags do you need to complete a set of construction documents? Well, in Revit, you can create a multi-category tag. This will be the same tag (aesthetically) that identifies a common property in any element.

Unfortunately, Revit doesn't provide a sample multi-category tag, so you'll have to make one. The objective of the next set of procedures is to create a new multi-category tag and then use it on various furniture items.

As mentioned earlier, you should create any new family by using a template. Doing so will ensure that you're using the correct data, so the family will behave as expected. This is what you're doing right now:

1. Click the Application button, and then choose New ➢ Family.
2. In the Annotations folder, locate the file called Multi-Category Tag.rft.
3. Open the Multi-Category Tag.rft template.
4. Because you've started the family by using a template, the Ribbon has changed. On the Create panel, click the Label button.
5. Pick the point at the intersection of the two reference planes.
6. In the Edit Label dialog box, add the Family Name and Type Name parameters, as shown in Figure BC1.80.

**FIGURE BC1.80:** This time you're adding two parameters. By selecting the Break check box, you tell Revit to stack the parameters.
7. In the Family Name row, select the Break check box (see Figure BC1.80).

8. Click OK.

9. Click the Application button, and select Save As ➢ Family. Place the file somewhere you can find it later.

10. Call the new tag Multi-Category Tag.

11. On the Family Editor panel, click Load Into Project.

12. In the NER-B1 project (or whatever project name you’re in at present), go to the Level 1 floor plan and zoom in on the northeast office in the east wing.

13. On the Annotate tab, click the Multi-Category button on the Tag panel, as shown in Figure BC1.81.

14. On the Options bar, select the Leader option, as shown in Figure BC1.82.
15. Again, on the Options bar, select Free End (see Figure BC1.82).

16. Hover your mouse over the furniture items shown in the room in Figure BC1.82. The tag reports the information for any item over which you hover. Pick the entertainment unit to the left of the room, and then pick two points to the right of the unit.

17. Click Modify. Select the tag you just placed into the model.

18. Click the Edit Type button.

19. For Leader Arrowhead, select Arrow Filled 15 Degree.

20. Click OK.

21. Using the grips on the tag, move it out of the way, and adjust the leader so it looks like the one in Figure BC1.82.

22. Add another tag to the credenza located on the north wall. Adjust this tag as well (see Figure BC1.82).

23. Add one more tag to the shelving on the south wall of the room, and adjust the leader so it looks acceptable (again, see Figure BC1.82).
Using multi-category tags is a great way to label a model. It’s nice because you don’t need specific tags for the various elements. These items could have been different types of furniture and casework. As long as they have a family name and a type name, the label tag will work.

Another way to record items in a model is by adding keynoting. This procedure is done in conjunction with a schedule. The last section of this chapter will focus on this procedure.

**Keynoting**

Keynoting has been used in construction documents dating back to the pharaohs. OK, maybe not that far back, but you get the point. Revit does a nice job in terms of tracking keynotes. The only issue is that nothing comes pre-keynoted in Revit. That is, a keynote value needs to be assigned to each item. If your company uses keynoting, you’ll have to assign a keynote to every item in Revit in your template.

That being said, let’s break down keynoting and start learning how to add keynotes to your model. You can add three different types of keynotes to a model: keynote by element, by material, and by user.

**Keynoting by Element**

Keynoting by element means you select an object and place the keynoted text. This procedure is the same as when you tag an object, except that this time the information you’re reporting is actually a Construction Specifiers Institute (CSI)—formatted keynote or a standard for your installation location.

Before you get started on this exercise, make sure there is a keynote.txt file to which Revit is pointing. Then follow along:

1. On the Annotate tab, click the small down arrow next to the word *Tag*.
2. Click Keynote Settings.
3. Make sure you're mapped to `C:\ProgramData\Autodesk\RVT_2016\Libraries\US Imperial\RevitKeynotes_Imperial_2010.txt` (RevitKeynotes_Metric_2010.txt), as shown in Figure BC1.83.
To use the keynoting by element function, follow this procedure:

1. In the Project Browser, go to the Level 1 floor plan.
2. Zoom in on a hallway sconce lighting fixture.
3. On the Tag panel of the Annotate tab, select Keynote ➢ Element Keynote, as shown in Figure BC1.84.

If no keynote tag is loaded, click Yes in the subsequent dialog box, and browse to Annotations ➢ Keynote Tag.rfa.

At this point, it’s up to you to determine which style of keynoting your firm uses. Do you keynote the plans with the CSI number, with the keynote description, or with a combination of the number and the description? Either way, you’ll be making a keynote schedule with these items in a list.
4. In the Type Selector, click Keynote Tag ➔ Keynote Text, as shown in Figure BC1.85.

![Figure BC1.85: Choosing Keynote Tag ➔ Keynote Text](image1)

5. Pick the wall sconce shown in Figure BC1.86.

![Figure BC1.86: Placing the leadered keynote](image2)

6. Pick a second point for the leader line.

7. Pick a third point to place the keynote text (see Figure BC1.86).
Because no keynote has been assigned to this family, you can specify one now. Revit lets you specify keynoting information either by assigning the information through the Properties dialog box or by placing a keynote tag, after which Revit will prompt you to specify the missing information.

After you pick the third point, Revit displays the Keynotes menu shown in Figure BC1.87. Follow these steps to place the keynote value into the sconce family:

1. Scroll to Division 26 Electrical, and click the plus sign.
2. Go to the group 26 51 00 Interior Lighting.
3. Go to the group 26 51 00.B2 Wall Mounted Incandescent Fixture, as shown in Figure BC1.87.
4. Click OK.
5. Drag the text to the right to see the arrow and the note clearly.
6. On the Tag panel of the Annotate tab, select Keynote ➢ Element Keynote again.
7. Pick another wall sconce, and place the keynote. Notice that this tag is consistent throughout.

8. Click Modify. Select the tag.

9. In the Properties dialog box, click Edit Type. Change Leader Arrowhead to Arrow Filled 15 Degrees.

The next style of keynoting allows you to specify an alternate keynote for an element. To begin, you’ll physically open the keynote text file and add some custom notes.

**Keynoting by User**

Sometimes you’ll need a completely custom keynote. Although you should try to stick to the CSI formatting, there will always be reasons to add your own. The first thing we need to look at is how to customize the Keynote list:

1. Save your model, and close out of Revit Architecture completely.

2. Using a text editor, open the file `C:\ProgramData\Autodesk\RVT 2016\Libraries\US Imperial\RevitKeynotes_Imperial_2010.txt` (`RevitKeynotes_Metric_2010.txt`).

   Note that your path may be different, especially on a company network.

   **WARNING** Before you start typing, be aware that when you need a separator between texts, you must press the Tab key. If you don’t, the code won’t work. Also, before you do this, be sure to make a copy of the original file.

3. Scroll down the list until you find the note 06 43 00.B1 3/4” Plywood Treads And Risers 06 43 00 (06430.B1 19 mm Plywood Treads and Risers 06430).

4. Click at the end of the note, press Enter to start a new line, and add the row 06 43 00.B2 Custom Hardwood Stairs 06 43 00 (06430.B2 Custom Hardwood Stairs 06430) (see Figure BC1.88).
5. Save the file as *Revit Keynotes Custom.txt*, and close the text editor.

6. Open Revit Architecture.

7. Open your project file.

8. Go to the Keynote settings, and browse to the new TXT file.

9. In the Project Browser, go to the Level 1 floor plan.

10. On the Tag panel of the Annotate tab, click Keynote ➢ User Keynote.

11. Pick the stairs, as shown in Figure BC1.89.
In the Keynotes dialog box, your new keynote is at the top of the list.

Pick the new keynote.

Click OK.

The stairs now have a custom keynote.

You have every kind of tag imaginable placed in your model, but you need to create one more legend to close the chapter: a keynote legend.

Creating Keynote Legends

Creating keynote legends is similar to creating schedules. Sometimes there is a fine line between what a schedule is and what a legend is. Keynotes almost seem to fall between these two concepts. Either way, follow this procedure to create a keynote legend:

1. On the View tab, click Legends ➢ Keynote Legend.

2. The name Keynote Legend is fine, so click OK in the dialog box that appears.

3. In the Keynote Legend Properties dialog box, only two fields are available, and they're both added to the legend. All you need to do is click OK, and the legend is created (see Figure BC1.90).
Well, that was easy! As mentioned before, if the data is there, it isn’t hard to create a query such as this to display the information.

One more item to address is where Revit looks for information regarding keynotes: in the settings listings.

**Keynote Settings**

To find the keynote settings, on the Annotate tab, click the drop-down arrow on the bottom of the Tag panel. This will allow you to click the Keynoting Settings button to open the Keynoting Settings dialog box, as shown in Figure BC1.91.

![Keynoting Settings dialog box](image)

*Figure BC1.91: Keynoting Settings displays where the keynotes are configured.*

Although you aren’t going to change anything, it’s noteworthy that the default path is by library location. This is good because when you upgrade Revit and have a custom keynote file, you can move it to the same directory, and Revit will read it into the model.

By specifying Numbering Method as By Keynote, you’ll share only one keynote legend. If you specify By Sheet, you can then drag the legend onto multiple
sheets, and only the keynotes that are visible on that specific sheet will be included in the legend.

As you can see, many items can be tagged, keynoted, and scheduled. If you feel that you could use more practice, go ahead and create some more schedules, tags, and keynotes.

**Are You Experienced?**

**Now you can...**

✔ ✔ create several different types of schedules

✔ ✔ add custom fields to the schedules that calculate values

✔ ✔ create material takeoffs that give you up-to-the-second information as you add items to the model

✔ ✔ create legends by using a blank view and basically drafting items into the model

✔ ✔ import AutoCAD-generated data to create a legend that looks exactly like your CAD

✔ ✔ create drawing sheets, add a schedule, and manipulate a schedule to fit on the sheet

✔ ✔ add tags to the model in addition to the tags that were automatically added when you placed the components

✔ ✔ place tags that reach into a component and display different materials

✔ ✔ create custom tags to display any information